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SFA 

1) Import Disposal Information 
(subscription only)

2) Batch Reports – reorder and drag 
and drop

3) Asset List: Display totals on numeric 
columns

4) Import assets: Improve performance 
on high volume imports

5) New Drag & drop ability on select 
dialogs

2022.0

6) Call-home License Entitlement

7) Disposals: More flexible process

8) Asset List: Export to Excel 
enhancements

9) “Browse for folder” usability 
enhancements 

10) Advanced Search options in Help

New Features

Multiple

Depreciation

Tracking

Product Key:
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What’s New at a glance
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Feature tip - Depreciation
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Sage Fixed Assets 

enhancements

11/2/2021 5



Import asset disposal information
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• Familiar Custom Import 

interface

• Excel template provided

• Field Map file provided

Customer request:

“Please incorporate an import 

function for disposing of 

assets. We have entities that 

dispose of hundreds of assets 

in a period and selecting them 

each individually is time 

consuming and error-prone.”



Import asset disposal information
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• Fully* dispose hundreds 

of assets in seconds

• An Excel template file and 

Help make importing easy

* Whole disposals supported in 2022.0. Partial 

disposals may be added in a later version



Import asset disposal information

(available for SFA subscribers*)
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Customer request:

“Please incorporate an import 

function for disposing of 

assets. We have entities that 

dispose of hundreds of assets 

in a period and selecting them 

each individually is time 

consuming and error-prone.”

* and during a free trial period



Drag & drop Enhancements
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• Customize Asset List

• Inventory Helper

• Global Task Manager
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Batch Reports – reorder and drag and drop
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New Up Down Buttons + Drag & Drop Functionality:

• Users can select one or more of the reports in the “Reports in Batch” list box and use the up5and down 6buttons to re-order the reports.

• Allow selection of 2+ contiguous reports with the [Shift] key. 

• Drag and drop a single report higher or lower in the list.

• Allow manipulation by mouse or keyboard (tab, arrows, enter) to select the report(s) and buttons.

Batch Reports – Reorder Reports + Drag and Drop
APPLICABLE TO ALL PRODUCTS WITH BATCH REPORTS: DEPRECIATION, DEPRECIATION / NETWORK, AND PREMIER DEPRECIATION.  ALL ENTITY TYPES.
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FIGURE 27 - EDIT BATCH DIALOG - FINAL FIGURE 28 - CUSTOMIZED ASSET LIST



Asset List: Display totals on numeric columns
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Customer request:

“It would be nice if … this assumes you have 

customized your asset list view to show 

acquired value or NBV etc. … you could see a 

subtotal of the amounts for the displayed 

group of assets."

February 2021
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APPLIES TO: DEPRECIATION (SU, NETWORK, PREMIER) FOR ALL ENTITY TYPES.  
Not applicable to: Planning, Tracking, or the Lite Depreciation products.

Asset List Totals

11/2/2021 13

Customers can right-click or double-click in the grid footer, beneath any numeric 

column in the Asset List to total the data. 

FIGURE 25 – ASSET LIST TOTALS - OVERVIEW

New

New
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Asset List Totals

11/2/2021 14

Additionally, customers can view and designate fields to be subtotaled in the Customize Asset List dialog. 

FIGURE 26 - CUSTOMIZE ASSET LIST DIALOG CHANGES



Import Assets – performance improvements
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User Story:

As a customer importing 10,000's of assets, 

I want to import all assets in one batch 

without the system crashing, so that I am 

get my work done faster and with 

confidence.

Currently, I have to divide the import file 

into smaller batches to import. It is a trial 

and error process to determine the correct 

number of assets for a single import.

• Issue: The computer’s memory (RAM) may not be 

sufficient for extremely large imports.

• Crystal Reports requires free memory to generate the 

exception report.  

• Now the exceptions report html and open in your 

browser; which requires less system resources.



Two registration options are available as buttons on the Register dialog (accessed through the Registration Status 

dialog).

• Activate – automatic registration where the Activation Code and Unlocking Code (subscription only) are 

automatically retrieved through the CE system by the SFA product.

• Enter Code – manual registration where the Activation Code and Unlocking Code (subscription only) are input by 

the customer on the Enter Codes. Verification of the registration occurs on the next product launch when a CE 

Check is run. 

Automatic registration: 

• The customer is required to enter their Customer Number and Serial Number on the Register screen before 

choosing a registration option. 

• The Register > Retrieve Code process initiates a CE check and automatically retrieves the Activation Code and 

Unlocking Code (subscription only) from the CE Server. 

• The production registration completes with a “Success” message provided there is internet access, the CE Server is 

not down, and there are no data entry errors.

11/2/2021 16

Registration Process Overview
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SFA applications will call home to Sage for 

initial activation and any future license 

changes.

• Initial customer benefit: No longer type in 

20-digit activation code (and another 20-

digit unlocking code for subscription)

• Ongoing customer benefits: applications 

will automatically download any entitlement 

change orders – including subscription 

renewals.

11/2/2021 17

Call home entitlement
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Customer benefits

• Simpler product activation (No need to type in the 20-

character codes)

• Simpler subscription renewal

• Simpler changes to active products/product mix

• Simpler updating to the license quantities for 

Network and Premier

• Simpler floating license activation (licenses without 

named users)

11/2/2021 18

Call home entitlement



Registration – before
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Navigate to the Product Registration 

screen and click the Register button.

Single User products:  

Help > Registration. . .

Call home entitlement



Registration – before
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Enter your product activation keys from 

your sales order email.

1. Serial Number

2. Activation Code

3. Unlock Code, if subscription

Click OK

Plus: Enter your Sage customer number 

on another screen.

Call home entitlement



Registration – Now
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Call home entitlement

Navigate to the Registration Status* 

screen and click the Register button.

Single User products:  

Help > Registration. . .

* Same Product Registration dialog 

with a new title



Enter your Sage customer number and 
product serial number.

1. Customer Number 

2. Serial Number

Click “Activate”

11/2/2021 22

Call home entitlement

Registration – Now
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Manual registration:

• The Register > Enter Code > Enter Codes dialog

o This process requires the Activation Code and Unlocking Code 

(subscription only) to be manually entered. 

• With a manual registration, the registration is verified on either:

o The next CE background check, or

▪ The application automatically schedules a CE Check for the 

next day/product launch) 

o If the CE Server was down or no internet access during the 

registration automatic re-check, then during the next product 

launch.

Why do a manual registration:

• It should not be necessary, but some customers may prefer this 

approach. 

• It is also a good way to temporarily bypass the CE check process if there 

is not internet access or the CE Server is down.  

Manual registration

11/2/2021 23
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Subscription Expiration - Grace Period and Read-Only Periods
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The subscription expires soon message has been removed.

FIGURE 13 – SUBSCRIPTION EXPIRES SOON MESSAGE – REMOVED

30-day Grace Period message is new

FIGURE 14 – 30-DAY GRACE PERIOD MESSAGE – SU PRODUCTS



© 2021 The Sage Group plc, or its licensors. All rights reserved.

Subscription Expiration - Grace Period and Read-Only Periods
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120-Day Read-Only Period message is revised

FIGURE 16 – 120-DAY READ ONLY PERIOD MESSAGE – SINGLE USER

PRODUCTS

FIGURE 15 – 30-DAY GRACE PERIOD MESSAGE – NETWORK & PREMIER CLIENT

FIGURE 17 - 120-DAY READ ONLY PERIOD MESSAGE – NETWORK & PREMIER

CLIENTS
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No Access message. 
Displays after the 30-day Grace Period and 120-day Read-Only Period have passed. 
A total of 150 days.

11/2/2021 26

Figure 18 – NO Access message – single user products FIGURE 19 - NO ACCESS MESSAGE – NETWORK AND PREMIER CLIENT
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Disposals: More flexible process

Customer Story:

As an accountant, I want the correct 

depreciation for disposed assets –

whether I enter the disposal before

or after running depreciation. 

DTR = Depreciation This Run

Previously

1. Remember to dispose assets before calculating 

depreciation for the disposal period. –or-

2. Remember to re-calculate depreciation for disposed 

assets by running depreciation twice – once as of the 

prior period and once as of the current period. 

Now

The system will calculate the correct depreciation-this-

run on assets disposed in the current period regardless 

of the disposal vs. calculation order.
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Disposals: More Flexible Process 
Purpose: Address one of the causes of the support call driver:  
' KB-16667 -Depreciation This Run Too High'

Corrective Action: Run depreciation twice (once for the prior period and again for the current period) to correct the asset(s). 

28

Cause: A disposal is recorded (or deleted) after depreciation has been calculated for the 
disposal period.

Example: A $36,000 asset is placed in service in January 2021. 
•Method: SF- straight-line, full-month averaging convention   Life: 3 years
•Thus, the monthly depreciation is $1,000, starting in January. $36,000 ÷ 36 months
•As of April 30, it has $4,000 of accumulated depreciation. 4 months x $1,000
•The asset is disposed in May 2021. 
•Due to the full-month convention, no depreciation is recorded in the disposal month.

BEFORE:  

EXPECTED: MONTHLY SEQUENCE FOR DISPOSALS

Record 
disposals

Calculate 
Depreciation

Run Reports

EXCEPTION: DEPRECIATION IS CALCULATED BEFORE THE RECORDING A DISPOSAL

Calculate 
Depreciation

Record 
disposals 

Run Reports
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NOW: 

11/2/2021 29

Record 
disposals

Calculate 
Depreciation

Run Reports

Calculate 
Depreciation

Record 
disposals 

Run Reports

OR



Asset List: Export to Excel enhancements
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• Column headers are bold 

with shading

• Row 1 is frozen by default –

headers won’t scroll out of 

view

• Total row with Excel® Sum 

formula on numeric fields
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“Browse for folder” usability enhancements 

Customer Request:

When running batch reports, it would help if the 

folder location is editable. Each time I go to run a 

batch, I have to navigate to the specific folder I 

want to save the reports.  If we could type or 

copy/paste in the location, it would save time.

From Sage City - Ideas

https://www.sagecity.com/support_communities/sage_fixed_assets/i/general/batch-reports
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“Browse for folder” usability enhancements 

The Browse button update is also implemented in the following seven areas – for 

applicable SFA modules

1. Preferences 

2. GTM > RUN BATCH

3. Prepare Reader Dialog form – Applicable to Tracking 

4. Receive Reader Data form – Applicable to Tracking 

5. Database List Manager 

1. Attachments 

2. Find Database

3. New Database

4. Rename Database

6. New Company > New Database 

7. Open Company > Find Database 

• Now the system will go to the 

specified location

• And the path can also be 

typed or pasted from the 

clipboard
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New Search options in Help 

Previously, the search ability in the help files for 
SFA and SFA PREMIER modules was basic and 
returned unneeded topics. Customers had to sort 
through many irrelevant topics.

Four new search features will save time for our 
customers – and possibly reduce support calls. 

Word(s)
Results-

before

Now: Search 

Title only, Incl. 

similar words

Now: Search 

Titles Only, 

Exact word

Bonus 40 4 4

Posting 43 8 5

Copy 77 6 13

Section 179 98 15 15

Dispose 196 27 0

Calculate 426 57 2

Asset 500 152 83

Example: The system displayed a list of topics for the term(s) and 
similar term(s) when found in either the title or the content. 
Now customers can refine the search.
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Custom Import – Exception Report Changes

WHY

When importing 10,000’s of assets in one batch the system may crash. Investigation found one cause is Crystal Reports inability to 

process very large data files causing the Import Exceptions Report to fail. The main cause of the crashes tended to be the number of 

warnings and less so the errors on validation. 

CHANGES

• The Import Exception Report is changed from a Crystal Report to an HTML report

• All formatting, including filepath, remains the same, except for page numbers, which do not apply to HTML reports. 

ADDITIONAL RESEARCH

NOTE: Under File > Preferences there is a checkbox option, Display Asset Warnings, to turn on or turn off (uncheck the box) 

warnings on Import Exceptions report. While this option can still be pursued, it was inconclusive if it could consistently resolve the 

issue. Giving further support to switching to an HTML report.

MORE WORK TO DO

- Other contributed causes – memory leaks

- Import with Beginning Fields
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Before: Crystal Reports

After: HTM report
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SFA Scanner 2.0
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SFA Scanner app 2.0

Unitech Scanner integration

Android OS 11 support

User-requested interface enhancements

Thoroughly updated components to provide the most 
secure connections possible

Scanner app

Multiple Depreciation Tracking PlanningKey: Scanner
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Unitech Android scanner integration

11/2/2021 38

Faster inventories –

Use the Unitech button in place of 

tapping the app scan icon
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Latest security

Your organization 
must approve the 
OneDrive access to 
company files, when 
enabled in their Azure 
Active Directory 
setup. 

Now – Admin approval Future - blue verified badge
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Infrastructure work
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SFA 2022.0

Security code scan and remediation

Security compliance

Integration Testing

Tracking: Update Microsoft Graph 
API for OneDrive connections

continued

.Net update to 4.8

DevExpress controls update

Gembox library replaced

PEP: Update for Windows OS 10+

Infrastructure Work – 1 of 2
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SFA Scanner app 2.0

Update Libraries

Update Analytics to Reporting

Security Penetration Test

New compiler target Android 11

Microsoft verified app for OneDrive 
connection (pending)

Infrastructure Work 2 of 2
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With this release, Sage made the following defect fixes to the indicated Sage Fixed Assets products. Fixes

with no specific product notation apply to all products that include the feature.

Folder box not present when browsing for New Database location
Fixed an issue where the folder box did not display on the Browse for Folder window when creating a new

database.

Bulk Edit incorrect message

Sage Fixed Assets—Depreciation (Premier, Network, and Standard)
When performing a Bulk Edit with an Effective Date of the Current Thru Date (CTD) on an asset that has a

Begin Date equal to the CTD, the validation report will no longer incorrectly display an “Asset is fully

depreciated” message.

Delete/Link in Image Manager does not apply to the currently open asset
Sage Fixed Assets—Depreciation, Tracking (Premier, Network, and Standard)

Fixed an issue where an image that is linked or deleted while in the Image Tab of Asset Detail does not show

as linked or deleted until exiting and returning to the asset.

Defect Fixes
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Unable to connect to OneDrive when performing an inventory
Sage Fixed Assets—Tracking (Premier, Network, and Standard)

Fixed occasional issues where connections to OneDrive failed.

Reset OneDrive Login missing from Receive Reader Data window
Sage Fixed Assets—Tracking (Premier, Network, and Standard)

Fixed an issue where the Reset OneDrive Login checkbox is missing from the Receive Reader Data window.

Defect Fixes
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Thank You
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